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1. Important

Ce guide électronique de I'utilisateur est
congu pour toutes les personnes qui utilisent
le moniteur de Philips. Prenez le temps de lire
ce Manuel d'utilisation avant d'utiliser votre
moniteur: Il contient des informations et des
notes importantes au sujet de I'utilisation de
votre moniteur.

La garantie Philips s'applique a la condition que
le produit soit manipulé correctement pour
son utilisation prévue et conformément aux
instructions d'utilisation, et sur présentation

de la facture d'origine ou du ticket de caisse
d'origine, indiquant la date de I'achat, le nom du
revendeur ainsi que le modéle et le numéro de
production du produit.

1.1 Précautions de sécurité et
d'entretien

D) Avertissements

Lutilisation de touches de réglages, d'ajustements
ou de procédures différentes de celles qui sont
décrites dans ce manuel pourrait présenter un
risque de choc électrique, délectrocution et/ou
mécanique.

Lorsque vous connectez et utilisez le moniteur
de votre ordinateur, lisez et respectez les
consignes suivantes :

Utilisation

* \Veulillez protéger le moniteur de la lumiere
directe du soleil, des forts éclairages et
ne I'utilisez pas a proximité de sources
de chaleur. L'exposition prolongée a
ces types d'environnement peut causer
des dommages au moniteur et une
décoloration.

«  Eloignez tout objet pouvant tomber dans
les orifices de ventilation ou empécher le
refroidissement correct des composants
électroniques du moniteur.

*  N'obstruez pas les orifices de ventilation
du boftier.

Lors de la mise en place du moniteur,
veillez a ce que la fiche d'alimentation et la
prise soient facilement accessibles.

Si vous mettez le moniteur hors tension en
débranchant le cable secteur ou le cable
d'alimentation CC, attendez 6 secondes
avant de rebrancher ces cables.

Utilisez toujours le cordon secteur fourni
par Philips. Si le cordon secteur est
manquant, veuillez contacter votre centre
de service local. (Reportez-vous au chapitre
Centre d'information a la clientele.)

Ne soumettez pas le moniteur a de fortes
vibrations ou a des impacts violents lorsque
vous ['utilisez.

Ne pas heurter ni laisser tomber le
moniteur pendant ['utilisation ou le
transport.

Entretien

Afin de protéger votre moniteur contre des
dommages, n'appuyez pas trop fortement
sur I'écran LCD. Lorsque vous déplacez le
moniteur; saisissez-le par son cadre pour le
soulever ; ne mettez pas vos mains ni vos
doigts sur I'écran LCD pour le soulever.

Débranchez le moniteur si vous envisagez
de ne pas l'utiliser pendant un certain
temps.

Débranchez le moniteur si vous voulez le
nettoyer. Pour ce faire, utilisez un chiffon
légerement humide.Vous pouvez aussi vous
servir d'un chiffon sec, pour autant que

le moniteur soit hors tension. Par contre,
n'utilisez jamais de solvants organiques,

tels que l'alcool ou des liquides a base
d'ammoniaque, pour nettoyer le moniteur.

Afin d'éviter tout risque d'électrocution ou
d'endommagement permanent a |'appareil,
n'exposez pas le moniteur a la poussiére ni
a la pluie.

Ne le mettez pas non plus en contact
avec de |'eau ni avec un environnement
excessivement humide.

Si votre moniteur est mouillé par de 'eau,
essuyez-le aussi rapidement que possible a



I'aide d'un chiffon sec. Si un corps étranger
ou de I'eau pénétrent dans le moniteur,
mettez-le immédiatement hors tension

et débranchez le cordon secteur. Retirez
ensuite le corps étranger ou épongez

I'eau et envoyez le moniteur au centre de
maintenance.

* Ne pas stocker ni utiliser le moniteur dans
des endroits tels qu'il risque d'étre exposé
a de la chaleur, a la lumiere directe du soleil
ou a un froid extréme.

* Afin d'assurer les performances optimales
de votre moniteur et |'utiliser pendant
plus longtemps, il doit se trouver dans
un endroit compris dans les plages de
température et d'humidité suivantes :

* Température : 0-40°C 32-95°F
* Humidité : 20-80% HR

Informations importantes a propos des
brulires/images fantdmes

* Activez systématiquement un programme
économiseur d'écran en mouvement
lorsque votre écran n'est pas sollicité.
Activez systématiquement une application
de rafraichissement périodique de votre
moniteur pour afficher un contenu statique
fixe. Laffichage sans interruption d'image
statique ou immobile sur une longue
période peut engendrer une « rémanence
a l'extinction », également appelée « image
résiduelle » ou « image fantdme » sur
votre écran.

*  Ces images « rémanentes », « en
surimpression » ou « fantémes » sont un
phénomeéne bien connu de la technologie
des panneaux LCD. Dans la plupart des
cas, cette « rémanence a I'extinction », ou
« image résiduelle » ou « image fantdbme
» disparait progressivement une fois
I'alimentation éteinte.

) Avertissement

Les symptomes de « brllure », d'« image
résiduelle » ou d'« image fantéme » ne
disparaitront pas et ne pourront pas étre
réparés si vous n'utilisez pas un économiseur

d'écran ou une application de rafraichissement
périodique de I'écran. Ce dommage n'est pas
couvert par votre garantie.

Service apres-vente :

* Le boftier peut uniquement étre ouvert par
un technicien qualifié.

* Sivous avez besoin de documents en
vue d'une réparation, veuillez prendre
contact avec votre centre de service local.
(Reportez-vous au chapitre « Centre
d'information a la clientéle. »)

*  Pour plus d'informations sur le transport,
veuillez vous référer a la section
« Caractéristiques techniques ».

*  Ne laissez pas votre moniteur dans une
voiture ni dans un coffre de voiture a la
lumiere directe du soleil.

© Remarque

Adressez-vous a un technicien si le moniteur ne
fonctionne pas normalement ou si vous n'étes
pas slr(e) de la procédure a suivre apres avoir
lu les instructions du mode d'emploi.



1.2 Notations

Les sous-parties suivantes décrivent les
différentes conventions de notation utilisées
dans ce document.

Notes, mises en garde et avertissements

Tout au long de ce guide, des blocs de texte
pourront étre accompagnés d'une icdne et
imprimés en caractéres gras ou en italiques.
Ces blocs contiennent des notes, des mises en
garde ou des avertissements. Ils sont utilisés de
la facon suivante:

© Remarque

Cette icone indique I'existence d'informations
et de conseils importants vous aidant a mieux
utiliser votre ordinateun.

@ Mise en garde

Cette icone indique I'existence d'informations
vous expliguant comment éviter
I'endommagement potentiel de votre matériel
ou la perte de données.

) Avertissement

Cette icéne indique qu'il existe un risque de
blessures et vous explique comment éviter le
probléme.

Il se peut que des avertissements apparaissent
sous des formats différents et ne soient pas
accompagnés d'icdnes. Dans ces cas-Ia, la
présentation spécifique de I'avertissement

est dictée par les autorités chargées des
réglementations.

1.3 Mise au rebut du produit et des
matériaux d’emballage

Déchet d’équipement électrique et
électronique - DEEE

Cette Marque sur le produit ou sur I'emballage
illustre que, sous la Directive Européenne
2002/96/EC gouvernant I'utilisation des
équipements électriques et électroniques,

ce produit peut ne pas étre jeté avec les
ordures ménageres. Vous étes responsable

de I'élimination de cet équipement a travers
une collection aux déchets d'équipements
électriques et électroniques désignés. Afin de
déterminer les emplacements de telles ordures
électriques et électroniques, veuillez contacter
votre représentant du gouvernement local pour
connaitre I'organisation de décharge d'ordure
dont dépend votre foyer ou le magasin ou vous
avez acheté le produit.

Votre nouveau moniteur contient des matériaux
recyclables et réutilisables. Des entreprises
spécialisées peuvent recycler votre produit pour
augmenter la quantité de matériels réutilisables
et minimiser la quantité a étre jetée.

Tous les matériaux d'emballage superflus

ont été enlevés. Nous avons essayé de notre
mieux de faciliter la séparation des matériaux
d’'emballage en des matériaux basiques.

Veuillez consulter votre réglementation locale
relative a la mise au rebut de votre ancien
moniteur et des matériaux d'emballage auprés
de votre revendeur local.



Informations relative a la reprise/recyclage
destinées aux clients

Philips établit des objectifs viables d'un point de
vue technique et économie, visant a optimiser
les performances environnementales du produit,
du service et des activités de I'organisation.

Concernant le planning, la conception et les
étapes de production, Philips se concentre

sur une fabrication de produits facilement
recyclables. Chez Philips, la gestion de la fin de
vie inclut I'implication aux initiatives nationales
de reprise et aux programmes de recyclage,
lorsque cela est possible, idéalement en
coopération avec la concurrence, en recyclant
tous les matériaux (produits et matériaux
d'emballage correspondants), conformément a
I'ensemble des lois sur I'environnement et au
programme de reprise de I'entreprise.

Votre produit est fabriqué avec des matériaux
et des composants de haute qualité, qui
peuvent étre recyclés et réutilisés.

Pour en savoir plus sur notre programme de
recyclage, visitez le site : http://www.philips.
com/sites/philipsglobal/about/sustainability/
ourenvironment/productrecyclingservices.page.




2. Installation du moniteur

2.1 Installation

El Contenu de la boite

PHILIPS

S

VGA (Optionnel)

DVI (Optionnel)

F1 Installer le socle

1. Placez le moniteur, face vers le bas, sur une
surface douce. Faites attention de ne pas
rayer ou endommager I'écran.

2. Tenez le socle avec vos deux mains.

(1) Attachez gentiment le socle a la
colonne jusqu'a ce que les trois attaches
rentrent dans les trous de position.

(2) Utilisez vos doigts pour serrer la
vis située en bas du socle, et fixez
fermement le socle a la colonne.




El Connexion a votre PC

PHILPS

@ Entrée d'alimentation CA
© Entrée DP

© Entrée DV

O Entrée VGA

© Verrou antivol Kensington

Connexion a un PC

1. Connectez le cordon d'alimentation a
I'arriere du moniteur fermement.

2. Mettez votre ordinateur hors tension et
débranchez son cable d'alimentation.

3. Connectez le cable de signal du moniteur
au connecteur vidéo situé a l'arriere de
votre ordinateur.

4. Insérez les cables d'alimentation de votre
ordinateur et du moniteur dans une prise
secteur.

5. Mettez votre ordinateur et le moniteur
sous tension. Si le moniteur affiche une
image, cela signifie que I'installation est
terminée.

2.2 Utilisation du moniteur

El Descriptions des boutons de contrdle

PHILPS
cooo

L

(3]

e/« fe?h4 SENSOR/A\ /0K [0}

L I | I
006 6 o o o0

Allume et éteint (MARCHE
@  |et ARRET) I'alimentation du
moniteur.

(-]

Ouvre le menu OSD.
S/0K Confirme le réglage de I'OSD.

A 'V |Ajuste le menu OSD.

SENSOR | Capteur d'alimentation.

O- |Ajuste le niveau de luminosité.

®© 60600 O

< Retourne au niveau précédent
du menu OSD.

touche de raccourci Smartlmage.
Vous pouvez choisir entre

six modes différents : Office
o @ (Bureau), Photo, Movie (Film),
Game (Jeux), Economy
(Economie) et Off (Arrét).




E1 Description de I'affichage sur écran
Qu’est-ce que Affichage a I'écran (OSD)?

La fonction d'affichage des menus a I'écran
(OSD) est présente avec tous les moniteurs
LCD de Philips. Elle permet a I'utilisateur

final d'effectuer des réglages d'écran ou de
sélectionner directement les fonctions du
moniteur par le biais d'une fenétre d'instructions
apparaissant a I'écran. Une interface conviviale,
semblable a celle reproduite ci-apres, apparait :

)] Power Sensor

Instructions simples et basiques sur les
touches de contréle

Dans le menu OSD ci-dessus, I'utilisateur peut
appuyer sur les boutons ¥ A situées sur le
panneau frontal du moniteur pour déplacer le
curseur, et sur OK pour confirmer un choix ou
une modification.

Le menu OSD

Vous trouverez ci-dessous une vue d'ensemble
de la structure de I'affichage sur écran.Vous
pourrez par la suite I'utiliser comme référence
lorsque vous voudrez plus tard revenir aux

différents réglages.
Main menu

Sub menu

— Power Sensor [ 8;“

VGA
E DvI
DisplayPort

r— Picture Format —

— Input

— Picture

— Information

— 0,1,2,3,4

Wide Screen, 4:3, 16:9, 1:1

— Brightness — 0~100
— Contrast — 0~100
— SmartContrast — On, Off
— Gamma — 1.8,20,22,24,2.6
— Over Scan — On, Off
Col r— Color Temperature —— 5000K, 6500K, 7500K, 8200K,
— Color
9300K, 11500K
— sRGB
— User Define Red: 0~100
E Green: 0~100
Blue: 0~100
f— language ~ — English. Espafiol, Frangais, Deutsch, Italiano,
Portugués, Pycckui, A 3T
— Horizontal ~— 0~100
—— OSD Settings
— Vertical — 0~100
[ Transparency — Off,1,2,3,4
“—— OsD Time out — 5, 10, 20, 30, 60
L Setup — Auto
— Power LED — 0,1,2,3
— H. Position — 0~100
| V. Position — 0~100
— Phase — 0~100
— Clock — 0~100
|— Resolution Notification — On, Off
— Reset — Yes,No



El Avis de résolution

Ce moniteur a été congu pour fonctionner de
maniere optimale a sa résolution native, qui est
1920 x 1080 @ 60 Hz. Quand le moniteur est
allumé a une autre résolution, le message d'alerte
suivant s'affiche a I'écran : Use 1920 x 1080

@ 60 Hz for best results (Utilisez la résolution
1920 x 1080 @ 60 Hz. pour des résultats
optimaux).

L'affichage du message d'alerte de résolution
native peut étre désactivé a partir de

Configuration dans le menu d'affichage a I'écran
(OSD).

Ed Fonction physique

Inclinaison

2.3 Enlever I'ensemble du socle pour
un montage VESA

Avant de commencer a enlever le socle du
moniteur, suivez les instructions suivantes
pour réduire le risque de blessure et/ou de
dommage.

1. Placez le moniteur, face vers le bas, sur une
surface douce. Faites attention de ne pas
rayer ou endommager I'écran.

2. Utilisez un tournevis plat pour enlever les
quatres vis mylar du bord du couvercle.




4. Enlevez I'ensemble du socle.

© Remarque
Ce moniteur utilise une interface de montage
conforme a VESA de 100mm x 100mm.

PHILIPS




3. Optimisation de l'image

3.1 Smartlmage

El De quoi s'agit-il?

Smartlmage propose des préréglages qui vous
permettent d'optimiser |'affichage de différents
types de contenu en ajustant dynamiquement la
luminosité, le contraste, la couleur et la netteté
en temps réel. Qu'il s'agisse de travaux sur

des applications de texte, d'affichage d'images
ou de visualisation d'un clip vidéo, Philips
Smartlmage vous propose un moniteur avec
des performances optimisées.

E1 Pourquoi en ai-je besoin?

Vous attendez de votre moniteur un affichage
optimisé de tous vos types favoris de contenu.
Le logiciel Smartlmage ajuste dynamiquement
la luminosité, le contraste, la couleur et la
netteté en temps réel pour une expérience de
visionnage améliorée avec votre moniteur.

E Comment ¢ca marche?

Smartlmage est une technologie Philips exclusive
et de pointe. Elle analyse le contenu affiché

sur votre écran. En se basant sur un scénario
choisi, Smartlmage optimise dynamiquement

le contraste, la saturation des couleurs et la
netteté des images pour des performances
d'affichage ultimes, le tout en temps réel par la
simple pression sur un bouton.

1 Comment activer Smartimage ?
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1. Appuyez sur i pour lancer Smartlmage
sur l'affichage a I'écran.

2. Appuyez sans arréter sur e» pour basculer
entre Office (Bureau), Photo (Photo),
Movie (Film), Game (Jeux), Economy
(Economie) et Off (Arrét).

3. L'affichage Smartlmage sur I'écran reste
affiché pendant 5 secondes, ou vous
pouvez également appuyer sur "OK" pour
confirmer.

4. Une fois Smartlmage activé, le schéma
sRVB est automatiquement désactivé. Pour
utiliser le modele sRVB, il faut désactiver
Smartimage en utilisant le bouton @D sur
le panneau avant de votre moniteur.

Outre I'utilisation de la touche @D pour le
défilement vers le bas, vous pouvez également
appuyer sur les boutons w A pour effectuer
votre choix, puis sur « OK » pour confirmer
la sélection et fermer le menu a I'écran
Smartimage.

Vous pouvez choisir entre six modes différents :
Office (Bureau), Photo, Movie (Film), Game
(Jeux), Economy (Economie) et Off (Arrét).

@ SmartImage

Office
Photo
Movie

Game

Economy

Off

»  Office (Bureau) : Optimise le texte et
adoucit la luminosité pour augmenter la
lisibilité et réduire la fatigue oculaire. Ce
mode optimise la lisibilité et la productivité
de facon significative lorsque vous travaillez
avec des feuilles de calcul, des fichiers PDF,
des documents numérisés et d'autres
applications générales de bureau.



*  Photo : Ce profil associe la saturation
des couleurs, le contraste dynamique
et 'optimisation de la netteté pour un
affichage de photos et d'autres images
incroyablement clair avec des couleurs vives
- le tout sans effet parasite et sans couleurs
estompées.

*  Movie (Film) : La luminance accentuée,
la saturation profonde des couleurs, le
contraste dynamique et la netteté précise
permettent d'obtenir un affichage de
chaque détail dans les zones sombres de
vos clips vidéo, sans décoloration dans les
zones plus lumineuses, tout en maintenant
des valeurs dynamiques naturelles pour un
affichage vidéo optimal.

*  Game (Jeux) : Activez le circuit ‘overdrive’
pour obtenir un meilleur temps de
réponse, moins de flou sur les bords avec
des images qui changent rapidement sur
I'écran, un meilleur taux de contraste pour
les scénes claires ou foncées ; ce profil est
idéal pour les jeux.

+  Economy (Economie) : Dans ce profil,
le réglage de la luminosité et du
contraste ainsi que la rectification fine du
rétroéclairage permettent d'obtenir un
affichage correct pour les applications
quotidiennes de bureau, tout en diminuant
la consommation électrique.

e Off (Désactivé) : Pas d'optimisation par
Smartlmage.

3.2 SmartContrast

El De quoi s'agit-il?

Cette technologie unique analyse de fagon
dynamique le contenu a I'écran, et optimise
automatiquement le contraste du moniteur
pour une clarté visuelle et un plaisir visuel
maximum. Le rétroéclairage est ainsi augmenté
pour des images plus claires, plus précises et
plus lumineuses, ou diminué pour un affichage
clair des images sur fond sombre.
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E1 Pourquoi en ai-je besoin?

Vous attendez une clarté visuelle optimale

et un confort visuel, quel que soit le type de
contenu a I'écran. SmartConstrast controle
dynamiquement le contraste et ajuste le
rétroéclairage pour des images ou des

écrans de jeu et de vidéo claires, précises et
lumineuses, et pour du texte de bureautique
lisible. En réduisant la consommation électrique
de votre moniteur, vous réalisez des économies
énergétiques et prolongez la durée de vie de
votre écran.

El Comment ¢a marche?

Lorsque vous activez SmartContrast, ce dernier
va analyser le contenu affiché en temps réel

et ajuster les couleurs et controler l'intensité

du rétroéclairage. Cette fonction permet
d'optimiser dynamiquement le contraste

pour plus de plaisir dans votre divertissement,
visionnage de clips vidéo ou jeux.

3.3 Philips SmartControl Premium

Le nouveau logiciel SmartControl Premium

de Phillips vous permet de contrdler votre
moniteur a 'aide d'une interface graphique facile
a utiliser. C'en est fini des réglages compliqués,
ce logiciel pratique vous aide a ajuster la
résolution, a faire |'étalonnage des couleurs, les
réglages de 'horloge/de la phase, le réglage du
point blanc RGB, etc.

Grace aux dernieres technologies dans
I'algorithme principal, offrant un traitement et
un temps de réponse plus rapides, ce logiciel
compatible avec Windows 7 est basé sur des
icones avec une interface trés conviviale pour
vous aider a bien utiliser vos moniteurs de
Philips.

El Installation

*  Suivez les instructions pour l'installation.

*  Vous pouvez le lancer une fois I'installation
terminée.

* Sivous voulez lancer le logiciel
ultérieurement, vous pourrez alors cliquer
sur le raccourci du bureau ou de la barre
d'outils.



PHILIPS wwow phillps comiwelcome
Resured s Monitor driver and software installation
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Philps SmartControl
Sytem support and regaremens:
1.Sytam sppore Windows 7. Vi XP.
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Premier lancement — Assistant

La premiere fois apres l'installation de
SmartControl Premium, I'assistant est
automatiquement lancé.

L'assistant va vous aider a ajuster les
performances de votre moniteur, étape
apres étape.

Rendez-vous dans le menu Plug-in
(Branchement) pour lancer ['assistant
ultérieurement.

Vous pouvez ajuster davantage d'options
sans |'assistant depuis le panneau Standard.

[ & smartcontsolpremiam 2

SmartControl Premium

PHILIPS

Wizard

Youlneed to calbrate your dispay to get the most.
accurate color. We encourage you to use the smple
tuning process by selecting the Start Wizard button.
This process involves 2 seris of steps that wil et you
tune your dsplay and save the settings.

1. Choose the Start Wizard buton.

2. Folow the steps outined i this process,

3. Save your settings for future use.

Adiust Praferences

Audo

Auto Pot

E
g
E

B

_»
2
preets
Options Theft Deterrence
g SmartDeskcon
o start waarg

B3 Lancement depuis le panneau Standard :

Menu Réglage

Le menu Adjust (Réglage) vous permet
de régler les parametres Brightness
(Luminosité), Contrast (Contraste), et
Resolution (Résolution).

*  Suivez les instructions pour effectuer les

réglages.

* L'invite Cancel (Annuler) vous permet
d'annuler l'installation.

[ & smartContro remium

SmartControl Premium

]

Adjust

i

the Brightness to th el
the Brightness to
jhtnes

Color Lip
Brghtness
Contrast Brightness 2
Eco Power =
P = ]
- Resolton
e Undo Reset
Options
Heb
(<] smartControl Premium B

SmartControl Premium

]

Adjust

B4

Contrast
AdUst the Contrast (use the sider)
ghter mage areas.

1. Raie the Contrast unti

= e Contrast s0
Eco Power - *
. Resoltion
\g undo Reset
Options
Hep
@

e —

SmartContro| Premium

]

Adjust

Brghtness

o

Contrast

54

£co Power

Solution

8@

Help

PHILIPS

Resolution

Preferred resoliton. For
clear text, colrs, and
b

dspl . colors, 2
be set to s Preferred

your dispiay shouid

F your display s 2t 2 Non-Preferred rasakition, cick
on the Preferred button to change your resoluton to
Preferred.
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Menu Color (Couleur)

Le menu Color (Couleur) vous permet
de régler les paramétres RGB (RVB),
Black Level (Niveau noir), White Point
(Point blanc), Display Gamma (Gamma
d'affichage), Calibration (Calibrage),
Smartimage, et SmartKolor.

Suivez les instructions pour effectuer les

réglages.

Référez-vous au tableau ci-dessous pour les
éléments du sous-menu selon votre choix.

Exemple pour Color Calibration
(I'étalonnage des couleurs).

(Tocomrren

SmartContro| Premium

adiust w
S o8
X Bk Level
Cobr
whes pont
Dy Ganma
Eco Poer -
- Galbration
@ap
Smartimage
optons =
smanKobr
Help

7

PHILIPS

RGB

Al dispiayed colos are procuced by mixng Red, Bus,
e

prefer to adjust the RGB hes
1. Adjust the intensty of the Red, Green, and
Blue using the sider bars.
NOTE: Changng the RGB values can adversely effect
the dispayed colors.

Red 100
o Ow
Green 10
o Oy
Bue 10
=) oW

undo Reset

(oo

SmartContro| Premium

RGB
Bh!kILevel

Whee Pont

Display Gamma
)
Galbration
@p
Smartimage

SmarKolor

PHILIPS

Black Level

Impropery adjusted Black Level wil resut n 3 loss of
detal n darker mage areas. Adust the Black Level for
e best possbls picture qualy.
1. Adjust the biack level o the Red, Green, and
Blue using the sider bars.

Red s

(=] < (]

Grean s

o O 5]

B s

(=] © &
undo Reset

[ ] smartcontrol premium

SmartControl Premium

&

Adjust - lll
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PHILIPS

White Point

ich equal combinations
ful ntensty create
the overal cobr qualky. For the
colors clck the Reset buttan then
ite PO,
1. Please select the Whie Pont vakie for the best
kY.

(Tomairore
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Eco Power Display Gamma
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Galbration
ap

Smartimage

RGB possble color qual
\g BackLevel
Whte Pont
\g Depllarns: White Point 6500k
ERENE | ] © )
- Galbration
Y uf undo Resst
@"ﬁ
Smartimage
Options =
:! SmarKolor
Help.
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Display Gamma

Gamma i 2 component of the pil brightness n 3
dsplay. A lower Gamma vl produces biighter piels
and a Figher Gamma value produces darker piek. The
defauk vaoe for Gamrma &

o adust Gamma, Sartimage must be setto OFf.
Click the Smartimage Off button before adjusting.

1. Use the sider to select the desied Gamma,

Dsply Gamma

Undo. Reset

( el srarsContt P
f
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Color
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Eco Power 1
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Smertimage
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Calibration

Your 8oy needs to be proper calibrated n orger
for t to prod

Calibration shouid ah
step n the pr
you make indwidual adjustments to image quaiy or
whenever you move your display to 3 new boaton.
Make al other necessary adiustments to image
aualty frst

Press Show Me to leam how o use the

ibration to0s.
Finaly, press Start to begi the calibration
process.

F Enable color calbration

designed in colaboration with Joseph

o
Frotacied by US. atent o, 6,686,953

Show Me start

Quick View




« Show Me » lance le tutoriel d'aide a
I'étalonnage des couleurs.

Start (Démarrer) - lance la séquence
d'étalonnage des couleurs en 6 étapes.

Quick View (Visualisation rapide) charge les
images précédente/suivante.

Pour retourner au panneau d'accueil Color
(Couleur), cliquez sur le bouton Cancel
(Annuler).

Enable color calibration (Active I'étalonnage
des couleurs) - activé par défaut. Si la case
n'est pas cochée, il n'y a pas d'étalonnage
des couleurs, les boutons Démarrer et
Visualisation rapide sont grisés.

Les informations relatives au brevet doivent
figurer sur 'écran d'étalonnage.

Ecran de premier étalonnage des couleurs

Le bouton Previous (précédent) est
désactivé jusqu'au deuxiéme écran de
couleur.

Next (Suivant) permet d'accéder a la cible
suivante (6 cibles).

Allez finalement dans le panneau File >
Presets (Fichier > Préréglages).

Cancel (Annuler) ferme l'interface
utilisateur et retourne a la page Plug-in
(Branchement).

Smartlmage

Permet a I'utilisateur de modifier les réglages
pour un meilleur affichage selon le contenu.

Lorsque le mode Entertainment
(Divertissement) est activé, SmartContrast et
SmartResponse sont également activés.

" (1] smarControl Priom. @’

SmartControl Premium PHILIPS

Smartimage

= Smartimage optimizes your display for diferent screen
mage content. Make 3 sekection that matches the
content,

Adjust , Ill

768

Color

Whte Point

Display Gamma o mﬁ
Eco Power 9' of oAt
. cabrtn = &
lirb Photo Movie
e e S
G = 3t ~
st = =
4
Help Text
Menu Eco Power (Puissance éco)
[ & smartControl Premium X
SmartControl Premium PHILIPS

Power Savings

Use these settings to save power consumotion. Poier
be ssved by decreasing the brghtness of the,
backigh.

Haster Backight Brightness

e Use the sider to adjust the brightness of the backight.
Lower parcentage of bightness wl e ess watt o
povier.

ings can be realzed by decreasng

acki d on ighting condions. Sekect the
percentaga of the backight brghtness for your ghting
conditons.

:

-
Power Savngs [0 s € 750 @ 1005

Dm Room
[ ————

Schadule Power Savings

! Mastar Backight Brghtness

Options 5

i

Bright Now DimNow

Help “Tum Power OF tow
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Menu Options

Options>Preferences (Préférences) - n'est
disponible que lorsque vous choisissez
Preferences (Préférences) dans le menu
déroulant Options. Sur un écran non pris en
charge, mais compatible DDC/CI, seuls les

onglets Help (Aide) et Options sont disponibles.

| & smartcontrol Premium D

SmartControl Premium

Adiust ngunus

Audo

Auto Prot

i

iw

g
H

resets

Theft Deterrence

"

SmanDesktop

+d
g -
iw

Power LED Button Brightness 3

Hep -

&

» Affiche les réglages préférés actuels.

» Cochez la case pour activer la fonction. La
case a cocher est une touche a bascule.

* Enable Context Menu (Activer le menu
contextuel) sur le bureau est coché
(activé) par défaut. Enable Context Menu
(Activer le menu contextuel) affiche les
sélections SmartControl Premium pour
Select Preset (Choisir préréglage) et Tune
Display (Régler affichage) dans le menu
contextuel du bureau (clic avec le bouton
droit). Désactivé supprime SmartControl
Premium du menu contextuel (clic avec le
bouton droit).

e Licdbne Enable Task Tray (Activer barre
des taches) est coché (activé) par défaut.
Enable Context Menu (Activer le menu
contextuel) affiche le menu de la barre
des taches pour SmartControl Premium.

Cliquez avec le bouton droit sur I'icone de
la barre des taches pour afficher les options

du menu pour Help (I'aide) et Technical
Support (l'assistance technique). Check
for Update(Vérifier mise a jour), A About

15

(propos) et Exit (Quitter). Lorsque le menu
Enable Task Tray (Activer barre des taches)

est désactivé, I'icone de la barre des taches
n'affiche que Exit (Quitter).

Run at Startup (Exécuter au démarrage)
est coché (activé) par défaut. En cas de
désactivation, SmartControl Premium n'est
pas lancé au démarrage ou reste dans la
barre des taches. Pour lancer SmartControl
Premium, utilisez le raccourci depuis le
bureau ou la liste des programmes. Si cette
case est décochée (désactivée), aucun
préréglage ne se charge au démarrage,
méme s'il a été défini comme devant
s'exécuter au démarrage.

Activer le Mode transparence (Windows 7,
Vista, XP). Par défaut : 0% opaque.

Options>Audio - n'est disponible que lorsque
vous choisissez Volume dans le menu déroulant
Options.

Sur un écran non pris en charge, mais
compatible DDC/C], seuls les onglets Help
(Aide) et Options sont disponibles.

SmartControl| Premium

St P D

PHILIPS

Adjust the Volume of the integrated loudspeakers by
using the sid

Turn off the itegrated loudspeakers by checking the
Mute checkbox.

%5

Adiust o

-

Color
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I mite

-
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o
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Eco Power Weard
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Options. Theft Deterrence
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Option>Auto Pivot (Pivot automatique).

R

SmartControl Premium

]

Adjust Preferences

\g [
Color Aut ot
\ -
\g N
Eco Power Weard
T 2
\g Presets
Options Theft Detertence
SrartDsskco

&

Hep

PHILIPS

Auto Pivot
To manualy rotate the screen image, clck a rotation

button
Uncheck the Auto Pivot box to dsable automatic
sreen-mage rotation.

I™ Enable Auto Phot

Options>Input (Entrée) - n'est disponible que
lorsque vous choisissez Input (Entrée) dans le
menu déroulant Options. Sur un écran non pris
en charge, mais compatible DDC/CI, seuls les

onglets Help (Aide) et Options sont disponibles.

Aucun autre onglet de SmartControl Premium

n'est disponible.

[ srartcone Proriom
|

SmartControl Premium

Adiust Preferences
Audo
Color, Auto Pvot
| -
Eco Power k

Presets

i\

Optons Theft Deterence
\Q SmartDesktop
Hep

vt
PHILIPS

Tnput

Your disol

s multiple nputs (connections on back
u can hook up muktple diferent

sources 3t the same time. Use the Analog

Digital In buttons to select which source you'd lke to

view. You are curtently viewng the digital in mage.

TMPORTANT! I you switch nputs S
lose the abify to control your monor. In t

 have o use the Input Select button on the fi
of your montr to switch back to the orginal nput
before SmartControl functionalty can be restored.

Andog In Digtal In

Display Port

» Affiche le panneau d'instructions Source
et le paramétrage actuel de la source

d'entrée.

En mode affichage d'entrée simple, ce

panneau n'est pas visible.
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*  Options>Theft Deterrence (Systéme
antivol) - Le panneau Theft Deterrence
(Systéme antivol) n'est disponible
que lorsque vous sélectionnez Mode
antivol dans le menu déroulant Plug-in

(] smartControl Premium 2
Premium
SmartControl PHILIPS
Theft Deterrence
o eharece prtacs your dnhy s
\ e o T O e i

e
e R 6o e (i, e

i ol

LR Preferences needed to authorize use on another computer.
-
Gobr s
-
o
Eco Power Weard
‘e 4
2
o
Options Theft Deterrence
oo
e Deterence OF
Help on

Pour activer Theft Deterrence (le systeme
antivol), cliquez sur le bouton On (Marche) et
I'écran suivant s'affichera :

e Saisissez un PIN de 4 a 9 chiffres
seulement.

* Une fois le PIN saisi, le fait d'appuyer sur
le bouton Accept (Accepter) affiche une
boite de dialogue sur la page suivante.

e Minutes minimum réglé sur 5. Le curseur
est réglé sur 5 par défaut.

* Inutile d'attacher I'écran a un autre
dispositif pour entrer en mode Theft
Deterrence (Systéme antivol).

Apres la création du PIN, le panneau Theft

Deterrence (Systeme antivol) indique Theft

Deterrence Enabled (Systéme antivol activé) et

affiche le bouton PIN Options (Options PIN) :

* Theft Deterrence Enabled (Systeme antivol
activé) s'affiche.

» Désactiver le Theft Deterrence (Systeme
antivol) ouvre I'écran de la page suivante.

* Le bouton PIN Options (Options PIN)
n'est disponible qu'apres avoir crée le PIN.



Ce bouton permet d'accéder au site Web
de PIN sécurisé.
Menu Help (Aide)

Help>User Manual (Aide>Manuel d'utilisation)
- n'est disponible que lorsque vous choisissez

User Manual (Manuel d'utilisation) dans le menu

déroulant Help (Aide). Sur un écran non pris
en charge, mais compatible DDC/CI, seuls les

onglets Help (Aide) et Options sont disponibles.

] SmartControl Premium X

SmartControl Premium PHILIPS

User Manual
=]

Adjust

4 hel

Us!Manua\

e

@

LR

e

oy
Eco Power -
’ i
syienD
X8

Verson

Options

User Manual Tech. support

8%

Help (Aide)>Version - n'est disponible que

lorsque vous choisissez Version dans le menu
déroulant Help (Aide). Sur un écran non pris
en charge, mais compatible DDC/CI, seuls les

onglets Help (Aide) et Options sont disponibles.

A m— @

Premium
SmartControl M4 PHILIPS
Version
Srartcont
| Verson 2,10 dtune-plp-R2011-08-15-1133-18
oDC/ctCommaricaton: ves P01 471
Adjust Copyright © 1993-2011 Portrak Displays, Inc.
Color
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oo Power
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Context Sensitive menu (Menu sensible au
contexte)

Le Context Sensitive menu (Menu sensible

au contexte) est Activé par défaut. Si Enable
Context Menu (Activer le menu contextuel) est
coché dans le panneau Options>Preferences
(Préférences), le menu est alors visible.

E] SmartControf Fremum
Select Presst L4
Tune Display

Power Saver 4

Office
Photo
Mowie
Text
Gramme
Economyr

Le Context Menu (menu contextuel) présente
quatre entrées :

e SmartControl Premium - si sélectionné,
I'écran About (A propos) s'affiche.

* Select Preset (Choisir préréglage) -
présente un menu hiérarchique des
préréglages enregistrés pour une utilisation
immédiate. La marque « coché » indique le
préréglage actuellement sélectionné. Il est
également possible de choisir le Factory
Preset (Préréglage usine) depuis le menu
déroulant.

» Tune Display (Régler affichage) - ouvre
le panneau de commande SmartControl
Premium.

*  Smartlmage - Vérifie les réglages existants

: Off (Arrét), Office (Bureau), Photo, Movie
(Film), Game (Jeux), Economy (Economie).

Menu Barre des tiches activé

Le menu barre des taches s'affiche en cliquant
avec le bouton droit sur I'icéne SmartControl
Premium, depuis la barre des taches. Cliquez
avec le bouton gauche pour lancer I'application.



o

Find Windows L4
Desktop Partiion
[dentify Partition
Align On

Help

Techmical Support
Check for Update
Aot

I Ext g

La barre des taches présente cing entrées :

Help (Aide) - acces au fichier du manuel
d'utilisation : Ouvre le fichier du manuel
d'utilisation en utilisant la fenétre du
navigateur par défaut.

Technical Support (Assistance technique) -
Affiche la page de I'assistance technique.

Check for Update (Contréler les mises

a jour) - ouvre la page de renvoi PDI et
vérifie la version de I'utilisateur par rapport
a la derniére version disponible.

About (A propos) - affiche les informations
détaillées de référence : version du produit,
informations sur la publication et nom du
produit.

Exit (Quitter) - Ferme SmartControl
Premium

Pour exécuter SmartControl Premium une
nouvelle fois, sélectionnez SmartControl
Premium dans le menu Program (Programmes),
double-cliquez sur 'icéne PC de bureau ou
redémarrez le systeme.

PHILIPS

SmartControl Premium

SmartControl
Version 2.10
dtune-plp-R2011-08-15-1133-18
Copyright ® 1993-2011 Portrait Displays, Inc.
Patents Pending
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Menu Barre des tiches désactivé

Lorsque la Barre des taches est désactivée
dans le dossier des préférences, seul le

choix Exit (Quitter) est disponible. Pour
supprimer completement SmartControl
Premium de la barre des taches, désactivez
Run at Startup (Exécuter au démarrage) sous
Options>Preferences (Préférences).

© Remarque

Toutes les illustrations de cette section sont
données a titre de référence uniquement. La
version du logiciel SmartControl peut étre
modifiée sans préavis.Veuillez toujours vérifier
le site Web officiel de Portrait www.portrait.
com/dtune/phl/enu/index pour télécharger la
derniere version du logiciel SmartControl.



www.portrait.com/dtune/phl/enu/index
www.portrait.com/dtune/phl/enu/index

3.4 Guide SmartDesktop

El SmartDesktop

SmartDesktop est dans SmartControl Premium.

Installez SmartControl Premium et choisissez
SmartDesktop dans les Options.

(& srariorsrot rmem 7
ium
SmartControl Fremiv PHILIPS
SmartDesklop
- Salect deskkop partiioning mode.
M Algn to partiion
Adjust
E 3 m =
vertical Horeontal
o
E & m
- Input Even Trioke Verticl
Q =il B
Eco - 8 Rght Vartical Lefe verticl
— . Prasets
Theft Deterenca Batiom Horizantal Top Horzental
‘Options
iofoc -
@ -
Help Identfy

» Align to partition check box (La case a
cocher Aligner) sur la partition permet
I'alignement automatique de la fenétre
lorsquelle est glissée dans la partition
définie.

* Sélectionnez la partition souhaitée en
cliquant sur l'icéne. La partition sera
appliquée sur le bureau et I'icone sera en
surbrillance.

* Identify (Identifier) offre un moyen rapide
pour afficher la grille.

A4
1w
= fjm e e e

u
i -
M

a8 s
w fw
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E1 Glisser-et déposer des fenétres

Une fois les partitions configurés et Aligner

sur la partition sélectionnée, une fenétre

peut étre glissée dans la zone et elle sera
automatiquement alignée. Lorsque la fenétre et
le curseur de la souris sont dans la zone, la zone
passe en surbrillance.

© Remarque

Si'le contour de la zone n'est pas visible lorsque
vous faites glisser la fenétre, « Afficher le
contenu des fenétres pendant leur déplacement
» est désactivé. Pour activer :

1. Control Panel (Dans le Panneau) de
configuration, cliquez sur System (Systeme).

2. Cliquez sur Advanced system settings
(Parameétres systéme avancés) (pour Vista
& Win7 OS, il se trouve dans le volet de
gauche)

3. Dans la section Performances, cliquez sur
Performance (Paramétres).

4. Dans la bofte, cochez Show window
contents (Afficher le contenu) des fenétres
pendant leur déplacement, et cliquez sur
OK.

Autre chemin alternatif :
Vista:

Control Panel (Panneau de configuration) >
Personalization (Personnalisation) > Window
Color and Appearance (Couleur et apparence
des fenétres) > Cliquez sur « Open Classic
appearance properties for more color options
» (Ouvrir les propriétés d'apparence classique
pour des options de couleurs supplémentaires)
> Cliquez sur le bouton « Effects » (Effets) >
cochez Afficher le contenu des fenétres pendant
leur déplacement.

XP:

Display Properties (Propriétés d'affichage) >
Appearance (Apparence) > Effects... (Effets...) >
cochez Afficher le contenu des fenétres pendant
leur déplacement.



Win7:
Aucun autre chemin alternatif disponible.

[l Options de la barre de titre

Partition du bureau est accessible a partir de la
barre de titre de la fenétre active. Cela foumnit
un movyen rapide et facile de gérer le bureau
ainsi que d'envoyer une fenétre quelconque
vers une partition sans avoir a glisser-déposer.
Déplacez le curseur dans la barre titre de la
fenétre active pour accéder au menu déroulant.

1 Menu de clic-droit

Cliquez-droit sur 'icéne Partition du bureau
pour afficher le menu déroulant.

Find Windows v
Desktop Partition ¥
Identify Partition

Align Off

*  Find Windows (Trouver les fenétres)
— Dans certains cas, l'utilisateur peut
avoir envoyé plusieurs fenétres vers la
méme partition. Find Windows (Trouver
Windows) affichera toutes les fenétres

ouvertes et déplacera la fenétre choisie en

premier plan.

* Desktop Partition (Partition du bureau)
— Desktop Partition (Partition du
bureau) affiche la partition actuellement
sélectionnée et permet a I'utilisateur
de basculer rapidement vers I'une
des partitions présentées dans la liste
déroulante.

Gl

Gyaa-e T
| vome | et magelyowt  Reterences  Maiings  Review  View E
=) 4 Tmestewpome =10 - EE i
U e AIBBCD! AaBbCel | Ex
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ciphos = - Bl sopes i

SmartDesktop Guide %
in SmarContl e, Tl S Contl e and s
SmantDesktop from Options. ==|
([ swarsControtPromm 2%
SmartControl Premivm PHILIPS
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© Remarque

Si plus d'un affichage est connecté, I'utilisateur
peut choisir l'affichage ciblé pour changer la
partition. Licone en surbrillance représente la
partition active actuelle.

* ldentify Partition (Identifier la partition)
— Affiche la grille contour sur le bureau
pour la partition actuelle.

» Align On/Align Off (Aligner activé/Aligner
désactivé) — Active/désactive la fonction
dalignement automatique par glisser-
déplacer.

»  Exit (Quitter) — Desktop Partition (Ferme
Partition) du bureau et Display Tune
(Régler I'affichage). Pour réinitialiser, lancer
Display Tune (Régler l'affichage) depuis
le menu Démarrer ou le raccourci sur le
bureau.

H Menu de clic-gauche

Cliguez-gauche sur l'icone Partition du bureau
pour envoyer rapidement la fenétre active vers
une partition quelconque sans avoir a glisser-
déplacer. Relachez la souris pour envoyer la
fenétre vers la partition en surbrillance.

|

A Clic-droit sur la barre des tiches

La barre des taches contient également la
plupart des fonctionnalités prises en charge
dans la barre de titre (a I'exception de I'envoi
automatique d'une fenétre vers une partition).

Identify Partition
Align Off

Bright Light
D Light

Help

Technical Support
Check for Update
About

Find Windows (Trouver les fenétres)

— Dans certains cas, I'utilisateur peut

avoir envoyé plusieurs fenétres vers la
méme partition. Find Windows (Trouver
Windows) affichera toutes les fenétres
ouvertes et déplacera la fenétre choisie en
premier plan.

Desktop Partition (Partition du bureau) —
Desktop Partition (Partition du bureau)
affiche la partition actuellement
sélectionnée et permet a I'utilisateur

de basculer rapidement vers I'une

des partitions présentées dans la liste
déroulante.

Identify Partition (Identifier la partition)
— Affiche la grille contour sur le bureau
pour la partition actuelle.

Align On/Align Off (Aligner activé/Aligner
désactivé) — Active/désactive la fonction
d'alignement automatique par glisser-
déplacer.



Définitions des partitions de SmartDesktop

Nom

Full Desktop
(Bureau complet)

Description

Applique tous les parametres a I'ensemble du bureau.

Vertical Evalue la résolution de I'écran et divise I'affichage en deux
zones verticales de taille égale.
Pour maintenir la configuration verticale 90/270.
Horizontal Evalue la résolution de I'écran et divise I'affichage en deux

zones horizontales de taille égale.

Pour maintenir la configuration horizontale 90/270.

Vertical Triple
(Triple vertical)

Evalue la résolution de I'écran et divise 'affichage en trois
zones verticales de taille égale.

Pour 90 Partition 1 horizontal haut Partition 2 horizontal
centre Partition 3 horizontal bas.

Pour 270 Partition 3 horizontal haut Partition 2 horizontal
centre Partition 1 horizontal bas.

Vertical Split Left
(Vertical fractionné
gauche)

Evalue la résolution d'écran et divise I'affichage en deux
zones verticales, le c6té gauche est une seule zone, le
c6té droit est divisé en deux zones de taille égale.

Pour 90 Partition 1 en haut Partitions 2&3 en bas.

Pour 270 Partition 1 en bas Partitions 2&3 en haut.

Vertical Split Right
(Vertical fractionné
droite)

Evalue la résolution d'écran et divise I'affichage en deux
zones verticales, le coté gauche est une seule zone, le
c6té droit est divisé en deux zones de taille égale.

Pour 90 Partitions 1&2 en haut Partition 3 en bas.
Pour 270 Partition 3 en haut Partitions 1&2 en bas.
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Nom

Horizontal Split Top
(Horizontal fractionné
haut)

Description

Evalue la résolution d'écran et divise I'affichage en deux
zones horizontales de taille uniforme, la zone supérieure
est unique, la zone inférieure est divisée en deux zones

de taille égale.

For 90 Partition 1 sur le c6té droit Vertical Partitions 2&3
sur le c6té gauche Vertical.

For 270 Partition 1 sur le coté gauche Vertical Partitions
2&3 sur le coté droit Vertical.

Horizontal Split
Bottom (Horizontal
fractionné bas)

Evalue la résolution d'écran et divise I'affichage en deux
zones horizontales de taille uniforme, la zone inférieure

est unique, la zone supérieure est divisée en deux zones
de taille égale.

For 90 Partitions 1&2 sur le coté droit Vertical Partition 3
sur le c6té gauche Vertical.

For 270 Partitions 1&2 sur le coté gauche Vertical
Partition 3 sur le c&té droit Vertical.

Even Split
(Fractionnement égal)

Evalue la résolution de I'écran et divise I'affichage en
quatre zones de taille égale.
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4. PowerSensor™

El Comment ca marche ?

*  PowerSensor fonctionne sur le principe
de transmission et la réception de signaux
“infrarouges” sans danger en détectant la
présence de utilisateur.

* Lorsque l'utilisateur se trouve devant
I'écran, I'écran fonctionne normalement,
avec les réglages pré déterminés que
I'utilisateur a choisi ex. luminosité, contraste,
couleur, etc.

*  En supposant que I'écran était réglé sur
100% de luminosité par exemple, quand
I'utilisateur quitte sa chaise et ne se
trouve plus devant I'écran, I'écran réduira
automatiquement sa consommation jusqu’a
80%.

Utilisateur non présent devant I'écran

La consommation électrique comme illustrée ci-
dessus sert uniquement de référence

El Réglage
Réglages par défaut

Comme réglages par défaut, (réglage 3),
PowerSensor est congu pour détecter la
présence de I'utilisateur situé entre 30 et 100
cm de l'affichage et a de cinq degrés a gauche
ou a droite de I'écran.

Réglages personnalisés
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Si vous préférez vous trouver dans une position
se situant en dehors des parametres listés
ci-dessus, choisissez un signal de puissance
supérieure pour une efficacité de détection
optimale: Plus le réglage est élevé, plus la
détection du signal sera forte. Pour une
efficacité PowerSensor maximum et pour

une détection correcte, veuillez vous placer
directement devant votre écran.

* Sivous choisissez de vous placer a plus
de 100 cm de I'écran utilisez le signal de
détection maximum pour des distances
allant jusqu'a 120 cm. (Réglage 4)

*  Comme les vétements de couleurs
sombres ont tendance a absorber
les signaux infrarouges méme quand
['utilisateur se situe a 100 cm de ['affichage,
augmentez la puissance du signal quand
vous portez du noir ou un autre vétement
sombre.

*  Vous pouvez retourner au mode par défaut
a tout moment (réglage 3).

Touche de raccourci Capteur de distance

Mode paysage/portrait

Les illustrations ci-dessus ne sont données qu'a
titre de référence



El Comment ajuster les réglages

Si PowerSensor ne fonctionne pas correctement
dans ou a I'extérieur de la portée par défaut,
voici comment améliorer la détection :

e Pressez la touche de raccourci
PowerSensor.

* Vous vous trouverez en position par défaut
‘3" sur la barre de réglage.

* Ajustez la détection de réglage
PowerSensor vers le Réglage 4 puis pressez
OK.

* Testez le nouveau réglage pour vous
assurer que PowerSensor vous détecte
correctement dans votre position actuelle.

* La fonction PowerSensor est concue
pour fonctionner uniquement en mode
Paysage (position horizontale). Une
fois PowerSensor allumé, il s'éteindra
automatiquement si I'écran est utilisé
en mode Portrait (90 degrés/position
verticale) ; il s'allumera automatiquement si
I'écran est remis dans sa position Paysage
par défaut.

© Remarque

Le mode PowerSensor choisi manuellement
restera opérationnel a moins que et jusqu'a ce
qu'il soit réajusté ou que le mode défaut soit
rappelé. Si vous trouvez que PowerSensor est
excessivement sensible au mouvement proche
pour une raison quelconque, réglez-le sur une
puissance de signal inférieure.



5. Caractéristiques techniques

vertical

Type de dalle d'écran TFI-LCD
Rétroéclairage DEL

Taille de la dalle 27" L (68,6cm)
Proportions 16:9

Taille de pixel 0,31 x 0,31 mm
Luminosité 300 cd/m*
SmartContrast 20,000,000:1

Taux de contraste (typique) 1000:1

Temps de réponse (typique) 5ms

Résolution optimale 1920 x 1080 @ 60Hz
Angle de vue 170° (H) / 160° (V) @Tx Contraste > 10
Couleurs d'affichage 16,7 M

Fréquence de rafraichissement 56 Hy - 76 Hz

Fréquence horizontale

30 kHz - 83 kHz

sRGB

Entrée de signal

OUl

PortAffichage, DVI (Numérique), VGA (Analogique)

Signal d'entrée

Fonctions pratiques

Synchro séparée, synchro sur vert

ED/< to7A4 SENSOR /A /0K 0}

Langues OSD

Anglais, Francais, Allemand, Espagnol, Italien, Russe,
chinois simplifié, portugais

Autres fonctions pratiques

Verrouillage Kensington

Compatibilité Plug & Play

DDC/CI, sRGB, Windows 7/Vista/XE Mac OSX, Linux

Inclinaison -5/+20

| Alimentation ]
Mode Marche 338 W (typ.)
Mode marche (Mode ECO) 18 W (typ.)
Consenisiien ¢ liee Tensjon d'entrée Tension d'entrée Tension d'entrée
L At Sy e CA a 100VCA +/- | CAa115VCA +/- | CA a230VCA +/-
50) 5VCA, 50Hz +/- 5VCA, 60Hz +/- 5VCA, 50Hz +/-

3Hz 3Hz 3Hz

Fon'c‘tlonnement normal 203 W 203W 203W
(typique)
Veille (En attente) 03W (typ.) 03 W (typ.) 03 W (typ.)
Eteindre 01 W (typ.) 01 W (typ.) 01 W (typ.)
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Dissipation thermique*

Tension d'entrée
CA a 100VCA +/-
5VCA, 50Hz +/-
3Hz

Tension d'entrée
CA a 115VCA +/-
5VCA, 60Hz +/-
3Hz

Tension d'entrée
CA a 230VCA +/-
5VCA, 50Hz +/-
3Hz

Fonctionnement normal

69,3 BTU/hr

69,3 BTU/hr

69,3 BTU/hr

Veille (En attente)

1,02 BTU/hr

1,02 BTU/hr

1,02 BTU/hr

Eteindre

0,341 BTU/hr

0,341 BTU/hr

0,341 BTU/hr

Voyant DEL d'alimentation

En mode : Blanc, mode En attente/Veille : Blanc (clignote)

Alimentation

Intégré, 100-240VCA, 50-60Hz

Produit avec socle (LxHxP)

639 x 484 x 224 mm

Produit sans socle (LxHxP)

639 x 405 x 64 mm

Produit avec socle 59 kg
Produit sans socle 50 kg
Produit emballé 8,9 kg

Plage de température (en
fonctionnement)

de 0°Ca 40 °C

Plage de température
(Hors fonctionnement)

de -20°C a 60°C

Humidité relative

de 20% a 80%

MTBF 30 000 heures

ROHS Oul

EPEAT Gold (www.epeat.net)
Emballage 100% recyclable

Substances spécifiques

Boitier 100% sans PVC BFR

EnergyStar

Approbations réglementaires

Couleur

OUl

CE Mark, FCC Class B, SEMKO, UL/cUL, BSMI, GOST,
TUV-GS, TUV-Ergo, Certificats TCO

Noir

Finition

Texture

© Remarque

[N

EPEAT Gold ou Silver n'est valide qu'aux endroits ot Philips a enregistré le produit.Visitez le site

www.epeat.net pour connaitre |'état de I'enregistrement dans votre pays.

N

Ces données sont sujettes a modifications sans préavis. Visitez www.philips.com/support pour

télécharger la derniére version de la brochure.

27


http://www.epeat.net
http://www.epeat.net
http://www.philips.com/support

5.1 Résolution et modes de
préréglage
El Résolution maximale

1920 x 1080 @ 60Hz (Entrée analogique)
1920 x 1080 @ 60Hz (Entrée numérique)

E Résolution recommandée
1920 x 1080 @ 60Hz (Entrée numérique)

3147 720 x 400 70,09
3147 640 x 480 59,94
35,00 640 x 480 66,67
37,86 640 x 480 72,81
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03

63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03
55,94 1440 x 900 59,89
70,64 1440 x 900 74,98
65,29 1680 x 1050 59,95
67,50 1920 x 1080 60,00

© Remarque

Veulillez noter que votre moniteur fonctionne
de facon optimale a sa résolution native de
1920 x 1080 @ 60Hz. Pour un affichage optimal,
veuillez suivre cette recommandation quant a la
résolution.
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6. Gestion de I'énergie

Si vous disposez d'une carte vidéo compatible
VESA DPM ou d'un logiciel installé sur votre
PC, le moniteur va automatiquement réduire
sa consommation électrique lorsqu'il n'est
pas utilisé. En cas d'activation d'une touche
du clavier, de manipulation de la souris ou

de détection d'un autre appareil d'entrée, le
moniteur va automatiquement « se réveiller
». Le tableau suivant affiche la consommation
électrique et la signalisation de ladite fonction
d'économie d'énergie :

104 Energie| Couleur du
Mode VESA Vidéo H-sync [ V-sync il ey BEL
Actif AcTVvE | ou | ou [28W]  Bianc
(typ)
. 03W Blanc
Veille (En attente) | DESACTIVE[ Non | Non oy | (cignote)
Eteint DESACTIVE[ - -9 pEsacTive
(typ)

La configuration suivante est utilisée pour
mesurer la consommation électrique de ce
moniteur.

e Résolution native : 1920 x 1080

*  Contraste : 50%

e Luminosité : 300 nits

* Color temperature (Température de

couleurs) : 6500k avec motif blanc complet

© Remarque
Ces données sont sujettes a modifications sans
préavis.
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7. Informations Concernant
es Réglementations

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.
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Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.



@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont congues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.
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Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliére. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur 'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.



EN 55022 Compliance (Czech Republic Only)

“This device belongs to catagory B devicas as described in EN 55022, unless it is spacifi-
cally stated that it i  Class A devics on the speciiication labal. The following applies to
devices in Class A of EN 55022 (radius of protection up to 30 metars). The ussr of the
davica is obligad to take all staps necessary to remove sources of interferance 1o tale-
communication or sther devicas.

Pokd neni na fypovém &ithu potitase uvedena, I spedé do do tidy A podie EN 55022,
spada automaticky do tfidy B podie EN 55022, Pro zafizen! zafazend do tidy A (chranné
pésma 30m) podie EN 55022 platl nésleduficl. Dojde-li k rullan! telskomunikataich nebo
Jnjh zafizeni e uivatal povinnen provést takova opatfgni, atry nueni odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1T-42107
and PN-89/E-06251.

Wymagama Polskiego Centrum Badan i C erfyf kacfi

winno by sasilane = gniands
cufee 2 oby urzadzenia ()

nak bespie 3 uresdzeria @ wymag:
u\lkm'u ia :a ml il w PN-ULT42) 1 PN-BSEAMGZS].
Po*osm!c ms:mkcje' be;pre'c‘q.ens.rwa

aé holka abwodu ack
i preediugace

crexl ey, chwilowym werostasmi fub spad-
urradrenia dopasaujicego b

cirza wokdl nieg.
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT NET-
LEDNINGENS STIK OG STIKKONTAKT ER
NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI IR-
ROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA DU
PASSE PA AT KONTAKTENE FOR ST@MTIL-

FORSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
REZHENER2BE |




Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schédden durch Rontgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
llla 5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildrohre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf dun-
klem Untergrund zu verwenden (schlechte
Lesbarkeit und erhohte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder weni-
ger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLURB LEICHT
ZUGANGLICH SIND.
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EU Energy Label

4 \
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L 2010/1062 - 2011

)

The European Energy Label informs you on
the energy efficiency class of this product.
The greener the energy efficiency class of this
product is the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of

this product in use and the average energy
consumption for 1 year.

& Note
The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products produced and sold for China
market have to meet China RoHS request.
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8. Assistance client et
Garantie

8.1 Politique de Philips relative aux
pixels défectueux des écrans
plats

Philips s'efforce de livrer des produits de la plus
haute qualité. Nous utilisons les processus de
fabrication les plus avancés de I'industrie et les
méthodes les plus strictes de contrdle de la
qualité. Néanmoins, des défauts au niveau des
pixels ou des sous-pixels sont parfois inévitables

dans les dalles TFT utilisées dans les écrans plats.

Aucun fabricant ne peut garantir que tous les
panneaux seront sans pixel défectueux, mais
Philips garantit que tout moniteur avec un
nombre inacceptable de défauts sera réparé
ou remplacé sous garantie. Cet avis explique
les différents types de défauts de pixels et
définit les niveaux de défauts acceptables pour
chacun des ces types. Pour bénéficier de la
réparation ou du remplacement sous garantie,
le nombre de défauts de pixels sur un panneau
TFT doit dépasser ces niveaux acceptables. Par
exemple, pas plus de 0,0004% des sous-pixels
d'un moniteur ne peuvent étre défectueux.

En outre, étant donné que certains types ou
combinaisons de défauts de pixels sont plus
remarqués que d'autres, Philips détermine des
niveaux de qualité encore plus élevés. Cette
garantie est valable dans le monde entier.

sous-pixels

RGBM

Pixels
rixeis

Pixels et sous-pixels

Un pixel, ou élément d'image, est composé de
trois sous-pixels correspondants aux couleurs
primaires rouge, vert et bleu. Une image se
compose d'un grand nombre de pixels. Quand
tous les sous-pixels d'un pixel sont allumés, les
trois sous-pixels colorés apparaissent ensemble
comme un seul pixel blanc. Quand ils sont tous
éteints, les trois sous-pixels colorés apparaissent
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ensemble comme un seul pixel noir. Les autres
combinaisons de sous-pixels allumés et éteints
apparaissent comme les pixels individuels
d'autres couleurs.

Types de défauts de pixels

Les défauts de pixels et de sous-pixels
apparaissent sur |'écran de différentes facons. Il
existe deux catégories de défauts de pixels et
plusieurs types de défauts de sous-pixels dans
chaque catégorie.

Défauts de points brillants

Les points défectueux brillants sont des pixels
ou sous-pixels toujours allumés ou 'activés'. Un
pixel brillant est donc un sous-pixel qui ressort
du fond sombre de I'écran.Voici les types de
pixels brillants défectueux.

Un sous-pixel rouge, vert ou bleu allumé.

1 ¢

Deux sous-pixels allumés adjacents :
- Rouge + Bleu =Violet
- Rouge +Vert = Jaune
- Vert + Bleu = Cyan (Bleu pale)

Trois sous-pixels adjacents allumés (un pixel
blanc).



© Remarque

Un pixel brillant rouge ou bleu a une luminosité
supérieure a 50 % par rapport aux pixels
environnants, tandis qu'un pixel brillant vert est
30 % plus lumineux que les pixels environnants.

Défauts de points sombres

Les points défectueux sombres sont des pixels

ou sous-pixels toujours noirs ou « éteints ». Un
pixel sombre est donc un sous-pixel qui ressort
du fond clair de I'écran.Voici les types de pixels
sombres défectueux.

Proximité des défauts de pixels

Du fait que des défauts de méme type
provenant de pixels et sous-pixels proches les
uns des autres peuvent étre plus facilement
remarqués, Philips spécifie aussi des tolérances
pour la proximité des défauts de pixels.

Tolérances des défauts de pixels

Pour bénéficier, pendant la période de garantie,
d'une réparation ou d'un remplacement en
raison de défauts de pixels, le panneau TFT d'un
écran plat Philips doit avoir des défauts de pixels
et sous-pixels qui dépassent les tolérances
répertoriées dans les tableaux suivants.

DEFAUTS DES POINTS LUMINEUX NIVEAU ACCEPTABLE
1 sous-pixel éclairé 3
2 sous-pixels adjacents éclairés 1
3 sous-pixels adjacents éclairés (un pixel blanc) 0
Distance entre deux points lumineux défectueux* >15mm
Total des points lumineux défectueux, tous types confondus 3
POINTS NOIRS DEFECTUEUX NIVEAU ACCEPTABLE
1 sous-pixel noir 5 ou moins
2 sous-pixels noirs adjacents 2 ou moins
3 sous-pixels noirs adjacents 0
Distance entre deux points noirs défectueux* >15mm
Nombre total de points défectueux de tous types 5 ou moins
Nombre total de points lumineux ou noirs défectueux de tous 5 ou moins
types
© Remarque

1. 1 ou 2 sous-pixels adjacents = 1 point défectueux

2. Le moniteur est conforme a la norme 1SO9241-307. Conforme classe-I. (ISO9241-307 : méthodes
de test sur I'exigence ergonomique, I'analyse et la conformité des écrans électroniques)

w

1SO9241-307 est le successeur de la norme connue sous le nom de ISO13406, retirée par

I'Organisation Internationale de la normalisation (International Organisation for Standardisation, ou

ISO) le :2008-11-13.
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8.2 Assistance client & Garantie

Pour plus d'informations sur la garantie et le support additionnel pour votre région, veuillez consultez le
site www.philips.com/support.Vous pouvez également contacter le service d'assistance a la clientéle de
Philips de votre région, a I'un des numéros ci-dessous.

Informations de contact pour la région EUROPE DE L'EST :

Pays ASC Numéro clientéle Prix

Germany Siemens 1&S +49 01803 386 853 € 0,09

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0,10

Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0,09

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €008
Netherlands E Care +31 0900 0400 063 €0,10
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens &S +43 0810 000206 €007
Belgium E Care +32 078 250851 €006
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff

37


http://www.philips.com/support

Informations de contact pour la région EUROPE CENTRAL ET EUROPE DE L'EST :

Centre
Pays d'appel ASC Numéro clientéle
Belarus NA IBA +37517 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV” Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
serbia & NA Kim Tec d.oo. +381 1120 70 684
Montenegro
Slovenia NA PC H.and +386 1 530 08 24

NA Comel +380 562320045
Ukraine

NA Topaz-Service Company +38 044 245 73 31
- NA CPS +7 (495) 645 6746 (for repair)

ussia

NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697

NA Serware +36 12426331
Hungary .

NA Profi Service +36 1 814 8080

Informations de contact pour la région AMERIQUE LATINE :

Pays

Brazil

Argentina

Centre d'appel

Vermont

Numeéro clientele
0800-7254101

0800 3330 856

Informations de contact pour la Chine :

China

Numeéro clientele : 4008 800 008

Informations de contact pour 'AMERIQUE DU NORD :

Pays Centre d'appel ASC Numéro clientele
USA. EPl-e-center | Qwantech (877) 835-1838
Canada Supercom Supercom (800) 479-6696




Informations de contact pour la région Asie-Pacifique/Moyen Orient/Afrique :

Pays C:entre ASC Numéro clientele
d'appel
Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / : Hong Kong: Tel: +852 2619 9639
Macau A St Fhels Teemelogy L. Macau:Tel: (853)-0800-987
India NA REDINGTON INDIA LTD | (i1 800425 6356
Indonesia NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
Prima 7511530
South Korea | NA PCS One Korea Ltd. 080-600-6600
- After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer (65) 6882 3999
Care Center)
PCCW
Taiwan Teleservices | FETEC.CO 0800-231-099
Taiwan
Thailand NA fods Computer System Co. 1 (462) 9345498
South Africa | NA Sylvara Technologies Pty Ltd | 086 0000 888
United Arab | A AL SHAHD COMPUTER 00971 4 2276525
Emirates LLC
Israel NA Eastronics LTD 1-800-567000
FPT Service Informatic +84 8 38248007 Ho Chi Minh City
Vietnam NA Company Ltd +84 5113.562666 Danang City
pany Lt +84 5113.562666 Can tho Province
Philippines NA Glee Electronics, Inc. Eg%g ggzzgg; :Eg 23
Sril lanka NA no distributor and/or service
provider currently
Bangladesh NA Distributor: Computer Source | 880-2-9141747,9127592
8 Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-42927395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty |855-023-999992

buy-out)
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9. Guide de dépannage et
Foire Aux Questions

9.1 Recherches de causes de pannes

Cette page reprend les problemes pouvant
étre corrigés par un utilisateur. Si le probleme
persiste méme apres avoir appliqué ces
corrections, contactez un représentant du
service client Philips.

El Problémes les plus fréquents

Aucune image (le voyant DEL d’alimentation
ne s'allume pas)

* Assurez-vous d'avoir bien branché le
cordon d'alimentation dans une prise, et a
l'arriere du moniteur.

*  Puis contrdlez le bouton marche/arrét a
I'avant du moniteur. S'il est en position
éteint, appuyez pour le mettre en position
allumé.

Aucune image (Le voyant DEL d’alimentation
est blanc)
*  Vérifiez que l'ordinateur est allumé.

*  Vérifiez que le cable signal est bien branché
sur votre ordinateur.

*  Assurez-vous que le cable du moniteur ne
présente pas de broches tordues du cété
connexion. Si c'est le cas, il faut réparer ou
remplacer le cable.

* La fonction d'économie d'énergie est peut-
étre activée.

L'écran affiche

Attention

Check cable connection

*  Vérifiez que le cable du moniteur est bien
relié a votre ordinateur. (Veuillez également
vous référer au Guide de démarrage
rapide).
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e Vérifiez I'absence de broches tordues au
niveau du cable du moniteur.

*  Vérifiez que 'ordinateur est allumé.

Le bouton Auto ne marche pas

* La fonction auto ne marche qu'en mode
VGA-Analog (VGA-Analogique). Si les
résultats ne sont pas bons, vous pouvez
faire un ajustement manuel avec le menu
OSD.

© Remarque

La fonction Auto ne marche pas dans le mode
DVI-Digital (DVI-Numérique) car elle est inutile
dans ce mode.

Signes visibles de fumée ou d'étincelles
*  N'effectuez aucun dépannage.

e Débranchez immédiatement le moniteur
de la prise d'alimentation secteur pour
votre sécurité.

» Contactez immédiatement le service-client
de Philips.

E1 Problémes relatifs a I'image

L'image n'est pas centrée

*  Réglez la position de I'image en utilisant la
fonction « Auto » dans le menu OSD.

*  Réglez la position de I'image en utilisant
la fonction Phase/Clock (Horloge) du
Setup (installation) dans les commandes
principales du menu a I'écran. Elle ne
fonctionne qu'en mode VGA.

L'image vibre sur I'écran
» Controlez le branchement du cable signal
au niveau de la carte graphique ou du PC.

Un scintillement vertical apparait

*  Réglez I'image en utilisant la fonction
«Auto dans le menu OSD.

«  Eliminez les barres verticales en utilisant
la fonction Phase/Clock (Horloge) Setup



(d'installation) dans les commandes
principales du menu a I'écran. Elle ne
fonctionne qu'en mode VGA.

Un scintillement horizontal apparait

*  Réglez l'image en utilisant la fonction
«Autoy» dans le menu OSD.

*  Eliminez les barres verticales en utilisant
la fonction Phase/Clock (Horloge) Setup
(d'installation) dans les commandes
principales du menu a I'écran. Elle ne
fonctionne qu'en mode VGA.

I'image apparait floue, imparfaite ou trop
sombre

*  Réglez le contraste et la luminosité en
utilisant le menu a I'écran.

Une «image rémanentey, en «surimpressiony»
ou «image fantdmey apparait lorsque
I'alimentation est coupée.

» L'affichage sans interruption d'image
statique ou immobile sur une longue
période peut engendrer une « rémanence
a l'extinction », également appelée « image
résiduelle » ou « image fantdme » sur
votre écran. Ces images « rémanentes
», € en surimpression » ou « fantdmes
» sont un phénomeéne bien connu de la
technologie des panneaux LCD. Dans
la plupart des cas, cette « rémanence a
I'extinction », ou « image résiduelle » ou «
image fantdme » disparait progressivement
une fois l'alimentation éteinte.

* Activez systématiquement un programme
économiseur d'écran en mouvement
lorsque votre écran n'est pas sollicité.

» Activez systématiquement une application
de rafraichissement périodique de votre
moniteur LCD pour afficher un contenu
statique fixe.
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e Les symptdmes de « brllure », d'« image
résiduelle » ou d'« image fantdme » ne
disparaitront pas et ne pourront pas
&tre réparés si vous n'utilisez pas un
économiseur d'écran ou une application
de rafraichissement périodique de ['écran.
Ce dommage n'est pas couvert par votre
garantie.

L'image apparait déformée. Le texte est flou
ou brouillé.

* Réglez la résolution d'affichage du PC sur
celle recommandée pour le moniteur.

Des points verts, rouges, bleus, sombres et
blancs apparaissent a I'écran

* Les points rémanents sont une
caractéristique normale du cristal liquide
utilisé dans la technologie d'aujourd'hui ;
veuillez lire la section relative aux pixels
défectueux pour plus de détails.

Le voyant « Marche » est trop puissant et me
géne.
* Vous pouvez ajuster le voyant « Marche

» en utilisant Configuration DEL
d'alimentation dans le menu OSD.

Pour une assistance plus approfondie, veuillez
consulter la liste des Centres d'information aux
clients et contacter un représentant du service
client Philips.



Rép.:

Rép.:

9.2 Questions fréquentes -

SmartControl Premium

J'ai remplacé le moniteur de mon
PC par un nouveau moniteur et
SmartControl Premium ne marche
plus. Que faire ?

Rallumez votre PC et Vérifiez si
SmartControl Premium marche
correctement. Si ce n'est pas le cas,
vous devrez supprimer puis réinstaller
SmartControl Premium pour garantir la
bonne installation du pilote.

Les fonctions de SmartControl
Premium marchaient correctement
avant mais ne marchent plus
maintenant. Que faire ?

Si vous avez effectué les opérations
suivantes, il faudra peut-étre réinstaller
le pilote du moniteur.

Remplacez la carte graphique par une
autre

Mettez a jour le pilote vidéo

Activités sur le systéme d'exploitation, telles
que service pack ou patch

Exécutez la mise a jour de Windows ainsi
que le pilote du moniteur et/ou vidéo mis

a jour

Windows a été redémarré alors que le
moniteur était hors tension ou déconnecté.

Pour résoudre le probleme, cliquez avec le
bouton droit sur My Computer (Poste de
travail), puis sur Properties (Propriétés) ->
Hardware (Matériel)-> Device Manager
(Gestionnaire de périphériques).

Si'la mention « Plug and Play Monitor »
(Moniteur Plug-and-Play) accompagne
I'icéne du Monitor (moniteur), il vous
faudra procéder a une nouvelle installation.
Désinstallez simplement SmartControl
Premium et réinstallez-le.

Apres avoir installé SmartControl
Premium, lorsque je clique sur 'onglet
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Rép.:

Q4.

Rép.:

SmartControl Premium, rien ne se
passe ou un message d'erreur apparait.
Que s'est-il passé ?

Il se peut que votre carte graphique ne
soit pas compatible avec SmartControl
Premium. Si votre carte graphique fait
partie des margues susmentionnées,
essayez de télécharger le pilote de la
carte graphique le plus récent depuis
le site Internet correspondant a ladite
marque. Installez le pilote. Désinstallez
SmartControl Premium, et réinstallez-le
a nouveau.

Si cela ne fonctionne toujours pas, c'est
que la carte graphique n'est pas prise
en charge.Veuillez visiter le site Web

de Philips pour Vérifier si une nouvelle
version du pilote de SmartControl
Premium est disponible.

Lorsque je clique sur Product
Information (Informations produit),
toutes les informations n'apparaissent
pas. Pourquoi ?

Le pilote de votre carte graphique

n'est peut-&tre pas la toute derniére
version disponible et ne prend donc
pas totalement en charge l'interface
DDC/CI. Essayez de télécharger la toute
derniére version du pilote de la carte
graphique depuis le site Internet de la
marque de la carte. Installez le pilote.
Désinstallez SmartControl Premium et
réinstallez-le a nouveau.

Attention

Theft mode enabled




Q5.

Rép.:

J'ai égaré mon code PIN pour la
fonction Theft Deterrence (Systeme
antivol). Que faire ?

Le service client de Philips a le droit
de vous demander une preuve
d'identification et d'autorisation, pour
vérifier si vous étes le propriétaire légal
du moniteur.
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9.3
Q1:

Rép.:

Q2:

Rép.:

Questions générales

Lorsque j'installe mon moniteur, que

faire lorsque I'écran affiche « Cannot
display this video mode » (Impossible
d'afficher ce mode vidéo)?

Résolution recommandée pour ce
moniteur : 1920 x 1080 @ 60 Hz.

Débranchez tous les cables, puis branchez
votre PC sur le moniteur que vous utilisiez
précédemment.

Dans Windows Start Menu (Menu
Démarrer de Windows), choisissez Settings/
Control Panel (Paramétres/Panneau de
configuration) Dans Control Panel Window
(Fenétre du Panneau de configuration),
sélectionnez I'icdne Display (Affichage)
Dans Display Control Panel (Panneau

de configuration Affichage), sélectionnez
I'onglet « Settings » (Parametres). Dans
I'onglet Parameétres, dans la boite « desktop
area » (zone bureau), déplacez la réglette
sur 1920 x 1080 pixels.

Ouvrez les «Advanced Propertiesy»
(Propriétés avancées) et réglez le Taux de
rafraichissement sur 60 Hz. Cliquez ensuite
sur OK.

Redémarrez votre ordinateur, reprenez les
étapes 2 et 3 et vérifiez que votre PC est
bien réglé sur 1920 x 1080 @ 60 Hz.

Eteignez votre ordinateur. Débranchez
votre ancien moniteur puis reconnectez
votre moniteur LCD Philips.

Mettez votre moniteur sous tension, puis
allumez votre PC.

Quel est le taux de rafraichissement
recommandé pour le moniteur LCD?

Le taux de rafraichissement
recommandé pour les moniteurs LCD
est de 60Hz. En cas de perturbation au
niveau de I'écran, vous pouvez I'ajuster
sur 75Hz pour tenter de supprimer le
brouillage.



Q3: A quoi servent les fichiers .inf et .icm Rép.:  Pour un nettoyage normal, utilisez
sur le CD-ROM? Comment installer un chiffon propre et doux. Pour un
les pilotes (.inf et .icm) ? nettoyage plus en profondeur; utilisez
Rép.: Il s'agit des fichiers correspondant au de I'alcool isopropylique. N'utilisez pas
pilote de votre moniteur. Suivez les de solvant, comme I'alcool éthylique,
instructions de votre manuel d'utilisateur 'éthanol, I'acétone, I'hexane, etc.
pour installer les pilotes. Au moment Q8:  Comment modifier le réglage des
de l'installation de votre moniteur, couleurs sur mon moniteur ?
votre ordinateur peut vous demander
les pilotes du moniteur (les fichiers Rép.:  Vous pouvez modifier le réglage des
inf et .icm) ou un disque contenant couleurs depuis la commande du menu
les pilotes. Suivez les instructions pour a I'écran. Suivez la procédure ci-dessous,
insérer le CD'RQM inclus danls cet *  Appuyez sur « OK » pour afficher le menu
emballage. Leslp|lotes du momteur (les OSD (affichage & Iécran).
fichiers .inf et .icm) peuvent s'installer .
automatiquement. *  Appuyez sur la « DOWQ Arrow » (Fleche
vers le bas) pour sélectionner |'option
Q4: Comment ajuster la résolution ? «Color» (Couleur). Appuyez ensuite sur «
Rép.: Le pilote de votre carte graphique et OK> pour ouvrr le sous-mend d.e rleglalge
le moniteur déterminent ensemble d.es couleurs ; il y a trois réglages indiqués
les résolutions disponibles.Vous cl-dessous.
pouvez choisir la résolution voulue 1. Color Temperature (Température
depuis le Control Panel (Panneau de de couleurs) : Les six réglages sont 5
configuration) de Windows®, sous 000K, 6 500K, 7 500K, 8 200K, 9 300K
«Display properties» (Propriétés et 11 500K. Avec un réglage dans de
d'affichage). température de 5 000K, I'écran apparait
« chaud », avec une tonalité rouge-
Q5:  Que faire si je m'embrouille pendant blanc, alors que la température 11 500K
les réglages du moniteur ? est plus « froide », avec une tonalité
Rép.:  Appuyez simplement sur le bouton OK, bleu-blanc.
puis sélectionnez «Reset» (Réinitialiser) 2. sRGB:il s'agit d'un réglage standard
pour restaurer tous les parametres permettant d'assurer le bon échange
d'origine. des couleurs entre différents appareils
(par exemple les appareils photos
Qé6:  L'écran LCD résiste-t-il aux rayures ? numériques, les moniteurs, les
Rép.:  En général, il est recommandé d'éviter imprimantes, les scanners, etc.)
de soumettre la surface du panneau 3. User Define (Défini par I'utilisateur):
a un choc excessif et de le protéger I'utilisateur peut choisir son réglage
contre les objets émoussés ou pointus. préféré des couleurs en ajustant le
Lorsque vous manipulez le moniteur, rouge, le vert et le bleu.
assurez-vous de ne pas appliquer
de pression ou de force sur le c6té © Remarque
panneau. Cela pourrait affecter vos Une mesure de la couleur de la lumiére
conditions de garantie. émise par un objet lorsqu'il est chauffé. Cette
mesure s'exprime en termes d'échelle absolue
Q7:  Comment nettoyer la surface de (degrés Kelvin). Les températures Kelvin faibles,

I'écran LCD ?

44

comme 2 004K, sont rouges. Les températures



plus élevées, comme 9 300K sont bleues. La
température neutre est blanche, a 6 504K.

Q9: Est-il possible de connecter mon
moniteur LCD a n'importe quel PC,
station de travail ou Mac ?

Rép.:  Oui.Tous les moniteurs LCD Philips
sont compatibles avec les PC, les Mac
et les stations de travail standard.Vous
aurez peut-étre besoin d'un adaptateur
de cable pour brancher le moniteur
sur un systeme Mac. Nous vous
recommandons de contacter votre
représentant commercial Philips pour
plus d'informations.

Q10: Les moniteurs LCD Philips disposent-
ils de la fonctionnalité «Plug-and-Play»?

Rép.:  Oui, les moniteurs sont compatibles
'Plug-and-Play" avec Windows 7,Vista,
XP NT, Mac OSX et Linux.

Q11: Qu'appelle-t-on « image rémanente »,
« image en surimpression », « image
résiduelle », ou « image fantéme »
pour les écrans LCD?

Rép.: L'affichage sans interruption d'image
statique ou immobile sur une longue
période peut engendrer une «
rémanence a I'extinction », également
appelée « image résiduelle » ou « image
fantdme » sur votre écran. Ces images
« rémanentes », « en surimpression »
ou « fantdmes » sont un phénomene
bien connu de la technologie des
panneaux LCD. Dans la plupart des cas,
cette « rémanence a l'extinction », ou «
image résiduelle » ou « image fantdbme
» disparait progressivement une fois
I'alimentation éteinte.

Activez systématiquement un
programme économiseur d'écran en
mouvement lorsque votre écran n'est
pas sollicité.

Activez systématiquement une
application de rafraichissement
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périodique de votre moniteur LCD
pour afficher un contenu statique fixe.

) Avertissement

Les symptomes de « brllure », d'« image
résiduelle » ou d'« image fantéme » ne
disparaftront pas et ne pourront pas étre
réparés si vous n'utilisez pas un économiseur
d'écran ou une application de rafraichissement
périodique de I'écran. Ce dommage n'est pas
couvert par votre garantie.

Q12:  Pourquoi mon Affichage ne me permet
pas d'obtenir un texte clair, le contour
des caractéres affichés n'est pas net ?

Rép.:  Votre moniteur LCD fonctionne de
fagon optimale en utilisant la résolution
1920 x 1080 a 60Hz. Pour un affichage
optimal, utilisez cette résolution.
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